AVAYA

Virtualization Configuration using Avaya
Fabric Orchestrator

Release 1.1
NN48100-503
Issue 02.01
December 2016



©2015-2016, Avaya, Inc.
All Rights Reserved.

Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailld=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.

“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.

Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO
UNDER THE LINK “Avaya Terms of Use for Hosted Services” OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR

IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The
applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of
licenses or units of capacity is specified in the documentation or other
materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner,
whether as stand-alone products, pre-installed on hardware products,
and any upgrades, updates, patches, bug fixes, or modified versions
thereto. “Designated Processor” means a single stand-alone
computing device. “Server” means a Designated Processor that
hosts a software application to be accessed by multiple users.
“Instance” means a single copy of the Software executing at a
particular time: (i) on one physical machine; or (ii) on one deployed
software virtual machine (“VM”) or similar deployment.

License types

Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order.
Avaya may require the Designated Processor(s) to be identified in
the order by type, serial number, feature key, Instance, location or
other specific designation, or to be provided by End User to Avaya
through electronic means established by Avaya specifically for this
purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which
Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail
account in the name of a person or corporate function (e.g.,
webmaster or helpdesk), or a directory entry in the administrative
database utilized by the Software that permits one user to interface
with the Software. Units may be linked to a specific, identified Server
or an Instance of the Software.

Database License (DL). End User may install and use each copy or
an Instance of the Software on one Server or on multiple Servers
provided that each of the Servers on which the Software is installed
communicates with no more than one Instance of the same
database.

CPU License (CP). End User may install and use each copy or
Instance of the Software on a number of Servers up to the number
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indicated in the order provided that the performance capacity of the
Server(s) does not exceed the performance capacity specified for the
Software. End User may not re-install or operate the Software on
Server(s) with a larger performance capacity without Avaya’s prior
consent and payment of an upgrade fee.

Named User License (NU). You may: (i) install and use each copy or
Instance of the Software on a single Designated Processor or Server
per authorized Named User (defined below); or (ii) install and use
each copy or Instance of the Software on a Server so long as only
authorized Named Users access and use the Software. “Named
User”, means a user or device that has been expressly authorized by
Avaya to access and use the Software. At Avaya’s sole discretion, a
“Named User” may be, without limitation, designated by name,
corporate function (e.g., webmaster or helpdesk), an e-mail or voice
mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/Licenselnfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.

Copyright

Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Note that
each Instance of a product must be separately licensed and ordered.
For example, if the end user customer or Avaya Channel Partner
would like to install two Instances of the same type of products, then
two products of that type must be ordered.

Third Party Components

“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source

software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.

The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG
LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY
FROM THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL
PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE
AUTHORIZED IN WRITING BY AVAYA AND IF THOSE HOSTED
PRODUCTS USE OR EMBED CERTAIN THIRD PARTY
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE
LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S
EXPENSE, DIRECTLY FROM THE APPLICABLE THIRD PARTY
SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE G.729 CODEC, H.264 CODEC, OR H.265 CODEC, THE
AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES
THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY
AND ALL RELATED FEES AND/OR ROYALTIES. THE G.729
CODEC IS LICENSED BY SIPRO LAB TELECOM INC. SEE
WWW.SIPRO.COM/CONTACT.HTML. THE H.264 (AVC) CODEC IS
LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR
THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (1)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEQO”) AND/OR (Il) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

Compliance with Laws

You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United

States and Canada. For additional support telephone numbers, see
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the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities

Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose

This document provides an overview of the application and how to use it to manage your network.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator
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Chapter 2: New in this document

The following sections detail what is new in Virtualization Configuration using Avaya Fabric
Orchestrator, NN48100-503. See Avaya Fabric Orchestrator Release Notes for a list of supported
features.

Virtualization Device Information

Virtualization depends on Monitoring application for device connectivity information and no longer
relies on Configuration for the connectivity details. For more information, see the following sections:

* Virtualization Overview on page 10.

* One hop up provisioning requirements on page 15.

* Device Management on page 23.

Virtualization Preferences changes

vCenter Service is moved from Virtualization Preferences to Global Preferences tab. You can now
configure vCenter access information from Preferences ->Global. For more information, see
Administration using Avaya Fabric Orchestrator, NN48100-600.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator
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Chapter 3: Virtualization overview

Virtualization is an application that connects the vCenter server to the system to help the data center
administrator configure the network changes that apply to the data center. Before the introduction of
Virtualization, server administrators viewed only the virtualized server environment while the
network operators viewed only the network topology. Virtualization bridges these two environments
to deliver an end-to-end view of the virtualized data center from servers, to virtual machines (VM), to
networking devices.

Virtualization provides a link mechanism to the VMware vCenter server to transport data between
vCenter and Monitoring application so you can view both the virtual server and network
environment. As a result, the server administrator and the network operator are able to work more
efficiently together, such as a more effective troubleshooting process, as well as the ability to audit
and track the creation, migration and deletion of virtual machines within the data center. The
connection strategy between Virtualization and VMware vCenter is part of the server virtualization, a
solution that allows you to run multiple virtual machines on a single physical server. This
consolidation of servers helps reduce power consumption and cooling costs.

Virtualization connects to the VMware vCenter server and gathers the virtualized server topology
(VMs and vSwitches). Virtualization identifies the physical connectivity of each of the ESX servers to
the Avaya data switches and the data switch connectivity for the VMs. By stitching this information
to the network topology data that is automatically discovered through Monitoring application, you
can use Virtualization to view a complete end-to-end virtualized Data Center.

Virtualization is an important component of the Avaya Virtual Enterprise Network Architecture. The
Virtual Enterprise Network Architecture is an open, end-to-end virtualization architecture that
enables enterprises to build their own private cloud infrastructure. With a private cloud infrastructure,
you can improve work efficiency and reduce time-to-service. A unified fabric is formed to establish a
resilient infrastructure and maximize use of available bandwidth to simplify provisioning.

You can use Virtualization to automate device provisioning by following VMs as they migrate
through the network. As you move VMs from one server to another, you add and delete the
appropriate Network Profiles (QoS, ACLs) from the edge devices that are connected to the physical
servers. If you require a change in the network configuration, the change occurs automatically in
Virtualization, or you can manually request the action before the VM change is implemented. This
ensures that the network is configured before you migrate VMs from one server to another, to
ensure proper connectivity for the VM traffic.
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VMware vCenter

Virtualization connects the VMware vCenter to the Configuration. VMware vCenter is part of the
VMware vSphere, a system that manages collections of infrastructure such as storage and
networking of a data center. VMware vCenter Server provides important data center services such
as access control, performance monitoring and configuration. For more information about VMware
vSphere, visit http://www.vmware.com/support.

Within a server, you can use the vCenter Server to control the data center, and configure policies to
enable management of assignments and resources of virtual machines. After proper configuration, if
the network fails, servers are not impacted. Furthermore, VMware vCenter provides the list of MAC
addresses through Virtualization; however, information pertaining to the network switch and the slot
or port is not delivered through the VMware vCenter.

vCenter gathers resources from ESX/ESXi hosts and sends them to the system administrator. The
system administrator can then provision these resources to virtual machines. The following are the
vCenter components:

* Role Based Access Control (RBAC)
+ Core services

+ Distributed services

* Plug-ins

« Various interfaces

Role Based Access Control

You can perform various Role Based Access Control (RBAC) tasks required to manage roles within
AFO. You can add or delete a role name, provide group-level authentication functions and element
permissions.

Roles management tasks can be performed in Administration > Roles.

In AFO, you require appropriate permissions to perform any task. The administrator grants
permissions to users by assigning appropriate roles. RBAC supports two types of roles:

* Built-in
» Custom

The user can have read-only or write access permission. Read-only user permission can be
overridden with write access to provide both read and write permissions.

Using these roles, you can gain access to various elements with specific permission mappings.

For more information on RBAC and tasks required to manage roles within the AFO, see
Administration using Avaya Fabric Orchestrator, NN48100-600.
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Core Services

Core Services are comprised of a management service for virtual machines. The following table
details the Core Services components:

Component Description

Virtual machine provisioning Provisions virtual machines and their resources

Host and VM Configuration Virtual machine and host configuration

Resources and virtual machine inventory Organizes virtual machines and resources in the

management virtual environment and facilitates their management.

Statistics and logging Logs and reports on the performance and resource
of virtual machines, hosts, and clusters.

Alarms and event Management Tracks and warns of potential resource overuse or
event conditions.

Task scheduler Schedule actions to occur at a given time.

Consolidation Analyzes the capacity and use of the data center's

physical resources.

VvApp A vApp is similar to a virtual machine — it is multi-
tiered, but is a separate entity. With vApps, you can
perform operations, such as cloning, rebooting and
shutting down.

Distributed services

The vCenter Server manages and configures the Distributed services. Distributed services are
solutions that enable wider functionality within VMware vSphere. These solutions include VMware
DRS, VMware HA, and VMware vMotion.

vCenter plug-ins

Plug-ins are applications that add features and functionality to the vCenter Server. vCenter Server
plug-ins include VMware vCenter Converter and VMware Update Manager.

The VMware vCenter Converter allows you to convert physical machines and virtual to ESX/ESXi
virtual machines. You can import converted systems into any location in the vCenter Server
inventory. The VMware Update Manager allows you to enforce security standards across ESX/ESXi
hosts and managed virtual machines.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 12
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

VMware vCenter

vCenter services interfaces

vCenter Server contains the following interfaces:
+ ESX management — Connects to vCenter agent
* VMware vSphere APl — Connects to VMware management clients and third-party solutions.

» Database interface — Connects to Oracle, Microsoft SQL Server, or IBM DB2 to store
information, such as virtual machine configurations, host configurations, resources and virtual
machine inventory, performance statistics, events, alarms, user permissions, and roles.

* Active Directory interface — Obtains user access control information.

vCenter event types

The vCenter server processes the following types of events, to which Virtualization listens and
processes.

The following table describes these events.

Table 1: Virtual Machine Event

VMEvent Description
VmBeingCreatedEvent Virtual machine is being created.
VmBeingDeployedEvent Virtual machine is being deployed from a template.
VmBeingMigratedEvent Virtual machine is being migrated.
VmBeingHotMigrated Virtual machine is being hot-migrated.
VmBeingRelocatedEvent Virtual machine is being relocated.
VmRelocatedEvent Virtual machine is successfully relocated.
VmCloneEvent Base event for all clone operations.
VmCloneFailedEvent The virtual machine clone operation failed.
VmCreatedEvent Virtual machine is successfully created.
VmDeployedEvent Virtual machine deployment operation is complete.
VmDeployFailedEvent The deployment from a template failed.
VmDisconnectedEvent Virtual machine is disconnected.
VmFailedMigrateEvent The virtual machine migration failed.
VmMigratedEvent Virtual machine migration.
VmReconfiguredEvent Virtual machine is reconfigured.
VmRelocateFailedEvent The virtual machine relocation failed.
Table continues...
December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 13

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Virtualization overview

VMEvent Description
VmRemovedEvent Virtual machine is removed from the vCenter
management.
VmRenamedEvent Virtual machine is renamed.
VmUpgradeCompleteEvent Upgrade operation is completed.
VmUpgradingEvent Virtual hardware on a virtual machine is being
upgraded.
DvsCreatedEvent Distributed virtual switch is created.
DvsDestroyedEvent Distributed virtual switch is destroyed.
DVPortgroupCreatedEvent Distributed virtual port group is created.
DVPortgroupDestroyedEvent Distributed virtual port group is destroyed.
VssCreatedEvent Virtual standard switch is created.
VssDestroyedEvent Virtual standard switch is destroyed.
VssPortgroupCreatedEvent Virtual standard switch port group is created.
VssPortgroupDestroyedEvent Virtual standard switch port group is destroyed.

Use of virtual machines

Virtualization enables secure end-to-end virtualization of virtual machines, which are commonly
used in data centers to reduce costs by lowering cooling, space, and power requirements.

Virtualization automates service provisioning within the data center and oversees the virtual
machine lifecycle, including activation, mobility and removal of a virtual machine from the network.
You can view applications, servers and devices, either physical or virtual, and follow virtual machine
migrations between servers. Furthermore, you can generate reports of these migrations to provide
better monitoring regarding moves and network provisioning. As a result, network and server users
are better equipped to collaborate.

Virtual machines can promote challenging aspects within a network, such as inconsistent application
performance or troubleshooting issues. Virtualization allows the creation of templates and
application of rules to overcome these issues. For example, if you want a specific VLAN ID assigned
to a particular new device, you can create that type of rule.

One Hop Up Provisioning configuration

Many data networks are virtualized using the Shortest Path Bridging (SPB) technology.
Virtualization can help the operator to virtualize the end-to-end network to configure the following:

* VLAN on the edge devices of the SPB Cloud
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* VLAN, Traffic Profile/ACL/Bandwidth on the Access ports connected to the virtual world (ESX/
ESXi)

The VLAN/Traffic profile on the devices is applied using the preconfigured network profile auto
triggered by rules in Virtualization.

You can virtualize the entire end-to-end network using Virtualization to configure the VLAN
connectivity using predefined Network Profile and Rules at the edge device connected to ESX, and
the distribution or the core device, which forms the edge of the SPB Cloud.

The One Hop Up Provisioning (OHP) feature provisions the shortest path bridging MAC (SPBM)
core network devices automatically, in addition to provisioning the edge devices. This feature
facilitates the management of edge and core devices.

In order to provision a network device using Virtualization, the device must be managed in
Virtualization. A network switch that is connected directly to an ESX server is considered an edge
device. By selecting the uplinks from an edge device, the Virtualization operator can specify the core
devices to be managed. The core device forms the edge of the SPB cloud, known as the backbone
edge bridge (BEB).

One hop up provisioning prerequisites

Virtualization depends on Monitoring for device connectivity details. Enter the credentials for the
devices in the credentials Ul and the devices will be discovered in the monitoring application. In
Virtualization, devices are configured in the device management Ul and managed, inventory audit,
and hypervisor connectivity are executed on the devices.

The following prerequisites must be met before the One hop up Provisioning (OHP) feature can be
configured:

» Preferences (port dissociation for edge and core) are configured.

* Devices in the device management interface are configured, as follows:
- Select the Edge devices and units, if stacked to be managed.
- Select the uplinks to core (BEBs) devices using the Neighbor tab.
- Validate the link between the edge and the core device (BEB).

- Save the settings and click Confirm to trigger a port scan.

© Note:

* After the rediscovery of devices in Monitoring, you may need to reselect the devices in the
device management.

* The device management disables the selection of neighbor links if the remote device
(BEB) is not SPBm supported.

If a VM event occurs, the corresponding events can be seen in Monitor Events. Device details are
provided in the Applied Configurations and Pending/Failed Actions panes.
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For configuration examples of the OHP feature, see Administration using Avaya Fabric Orchestrator,
NN48100-600.

AFO Virtualization user interface

The Virtualization user interface has nine tabs:

» Topology — Displays applications, servers, and network devices across both physical and
virtual environments. Network displays Topology view by default, if configured.

* Inventory — Displays the end-to-end view of the connectivity between the data center and the
network devices. Inventory displays Tabular Inventory view by default, if configured.

» Event Monitor — Displays a list of each transaction that occurs within the vCenter server.

» Network Profiles — Provides the data center and network administrator a configuration
interface to define a network profile. A network profile consists of a set of configurations applied
to a network switch on a VLAN-id interface basis.

* Rules — Conditions applied to the virtual machine event to determine which of these network
profiles apply to which virtual machine event.

» Reports — Displays current and historical data from the data center and the network
connectivity, as well as any configuration changes that occurred within the data center.

Audit Logs — Displays details about configuration changes made to devices, as well as major
operations, and details about the inventory audit and the hypervisor connectivity.

» Device Management — Provides a configuration interface to manage network devices.

Network Validation — Displays a report showing the inconsistencies in the physical network
based on the Network Profiles attached to the VM network.

Topology

Use the Topology to view the end-to-end network topology including applications, servers, and
network devices across both physical and virtual environments. The Topology feature performs a
discovery of the devices in your network, and creates a topology map showing the discovered
devices and the connections between them. By default, the Topology view displays when
Virtualization is launched for the first time.

You can use the Topology view to perform the following:
« display a logical topology map of your network, such as Hosts server and the virtual machines
+ view link data and device connections

* view network information, such as Distributed Switch, PortGroups with VLAN, and MAC
address for virtual machines and the association with the Port Groups
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Inventory

» search on Host, VM, and physical device
* view events based on Host and VM
+ perform Network Discovery

Hover over a device or edge link to display information, such as Device IP, NIC, and connected
ports.

The following figure shows an example of the Topology view.
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Figure 1: Virtualization Topology view

You can track the VM network and provisioning changes, which help to monitor and troubleshoot the
network.

You can also view and monitor different stages of a VM life cycle, including create, migrate, edit,
and delete, as well as the following items:

* Virtual machine inventory from the data center
» Configuration changes made to devices

* VMware vCenter triggers that were not applied

Inventory

Inventory displays an inventory of virtual machines that are managed within Virtualization and the
data switch connectivity for the virtualized server topology. If a virtual machine is part of the
managed devices, the details of this virtual machine display in the Inventory pane. Inventory
displays the end-to-end view of the connectivity between the data center and the network devices.
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The information displayed in the panes is read-only, and contains the ESX/ESXi server information
along with the virtual machines, the MAC addresses and the associated network switches.

Inventory provides Hypervisor Inventory and Virtual Machines views.
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Figure 2: Hypervisor Inventory
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Figure 3: Virtual Machine Inventory
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Event Monitor

You can configure the Hypervisor Inventory and Virtual Machines panes to automatically refresh at
different intervals. You can choose one of the following options to configure an automatic refresh:

» off—default value, disables the refresh timer
» 30 secs—refresh every 30 seconds

* 1 min—refresh every 1 minute

* 5 min—refresh every 5 minutes

* 10 min—refresh every 10 minutes

Inventory displays Tabular Inventory view of the network when the Network View Setting is
configured to Tabular Inventory in Preferences. For more information about changing the Inventory
display to Tabular Inventory, see Administration using Avaya Fabric Orchestrator, NN48100-600.

You can use the filter to view the devices that are linked to the ESX Server or a VM. In the Filter
drop-down, a filtering option can be used to show only the devices linked to the VM(s). The search
can be further refined by entering a search string in the Filter box.

Event Monitor

Event Monitor displays a list of each transaction that occurs within the vCenter server. After you
create a virtual machine, it is sent through the network from vCenter to Virtualization. The monitor
displays the attributes of this creation, if the addition of the virtual machine was either successful or
partially successful, and if the creation failed or is in a pending state.

When you select a row within Event Monitor, the corresponding information appears in Applied
Configuration pane and Pending/Failed Actions pane. Click Refresh to refresh the Event Monitor
pane.
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Figure 4: Event Monitor

You can use the configuration option to automatically refresh the Event Monitor pane at different
intervals. The timer defaults to the off position, or you can choose one of the following options to
configure an automatic refresh:

» off—default value, disables the refresh timer
* 15 secs—refresh every 15 seconds

» 30 secs—refresh every 30 seconds

* 1 min—refresh every 1 minute

* 5 min—refresh every 5 minutes

* 10 min—refresh every 10 minutes

Network Profiles

Network configuration is simplified by providing a template called network profile for defining
configuration parameters and which are used across the device types. Because Virtualization
responds to lifecycle changes of VMs in the datacenter, network profiles can be used to define
device configurations to be performed.

Use the network profiles to define the VLAN and port configurations that are applied to a switch port.
A network profile provides a view of the VLAN, bandwidth, metering, access control and QoS
configuration and ensures that the trunk is correctly configured to support the VM traffic. After you
define and save a set of configurations, if a change occurs on the datacenter, the network profile is
applied to the corresponding data switch in the network to support this change.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 20
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Rules

Service ID [i-SID] and Service name are added into the Network Profiles.

Network profiles can be applied to different devices, such as 45xx, 55xx, and 86xx.

Rules

Rules are conditions to which network profiles are applied. Network profiles are applied to switch
ports based on preconfigured rules. As a result the rule binding service is dependent on the network
profile service. Virtualization provides a rule infrastructure to determine which network profiles are
applied to which virtual machine. You can define rules based on the location of the ESX server, the
application server type of the virtual machine, and the VLAN ID of the port groups to which a virtual
machine is connected.

A rule may have simple or complex criteria, and is executed for a virtual machine event only if the
event matches a single rule. You can configure rules to occur automatically or manually. Automatic
rules imply that if an exact rule match is found for a virtual machine event, then the configuration
defined in the related network profile is applied on the device. Manual rules imply that, if a rule is
matched for a virtual machine event, the configuration defined in the associated network profile is
not automatically applied to the network devices and you can apply the rule manually. For more
information about network profiles, see Network Profiles on page 20.

Reports

You can generate reports to view the current and historical data of the end-to-end data center and
network connectivity, as well as the configurations performed on the network devices in response to
the changes in the data center. You can generate the following types of reports:

* VM topology — Shows the connectivity of the VMs, the ESX server that the VMs are hosted
on, the Vswitch/ Dvswitch to which the VMs are connected, as well as the network devices
providing the link for these VMs.

» Applied configurations — Shows the configurations applied to the network devices. You can
generate this type of report to include only a specific time period.

» Pending/Failed actions — Shows the network device actions that are pending or failed. Details
about the result of the actions are displayed. You can generate this type of report to include
only a specific time period.

After you generate a report, you can print or export the given report in different formats, such as
Excel, Postscript, PDF, Word and PowerPoint.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 21
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Virtualization overview

Audit logs

Use the audit logs to view the operations you performed within Virtualization. Audit logs display the
virtual machine events processed and the configurations that were made on the network devices.
The audit logs detail changes that occurred to events, when these changes happened, and the
status of the event processing. You can apply filter options to the audit logs to search for information
by fields.

You can configure the audit log settings by clicking the Preferences icon on the quick toolbar. In the
Preferences section, you can set boundaries in regards to file size and the level at which debug logs
and audit logs appear. You can also enable audit log purge and configure the audit log retention
time.

Network Validation
Network Validation generates a report showing the inconsistencies in the physical network based on
the Network Profiles attached to the VM network.

You can generate the Network Validation report for various types of inconsistencies in the network.
Following are the types of inconsistencies:

* VLANs unavailable on the Edge device and one hop device for the existing VMs in the vCenter
* Unused VLANSs on the Edge device and one hop device

* VLANs available on the SPBm capable device for the existing VMs in the vCenter, but I-SID
not configured on the VLAN

* VLANSs available on the device, but required ports not associated to the VLAN
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Device Management
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Figure 5: Network Validation

Device Management

You can use the Device Management tab to view the managed devices in Monitoring and view the
status of the managed devices within Virtualization. You can view the number of devices and the
corresponding data relating to the type of switch, the slot number, when the device was last
updated, and if the device is managed or unmanaged.

o

Note:

Virtualization depends on Monitoring for device connectivity details. Enter the credentials for the
devices in the credentials Ul and the devices will be discovered in the monitoring application. In
Virtualization, devices are configured in the device management Ul and managed, inventory
audit, and hypervisor connectivity are executed on the devices. Once all the devices are
discovered in Monitoring, these devices are managed but the links between them are not
managed in the Device Management.

Device Management enable you to perform the following actions:

* Manage or unmanage edge and core devices.
* Manage or unmanage stack units of a stackable device in the Stack Units tab.

» Specify uplinks for the edge device (which is connected to ESX/ESXi server) in the Neighbor
tab. If the selected link is part of an MLT/SMLT, the Ul automatically selects other links of the
MLT/SMLT.
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Virtualization overview

+ Select an uplink for the edge device for Virtualization to automatically manage the core devices
(BEB), which are connected to the edge device.

+ Validate links between the edge and the core device (BEB).
* Filter by Device IP or Device type.

* View the Used license count.

© Note:

* After devices are rediscovered in Monitoring, devices may need to be reselected in Device
Management.

» The device manager disables the selection of neighbor links if the remote device (BEB) is
not SPBm supported.

» Refresh reloads the entire device information. Unsaved data is lost.

© Note:

The Virtualization application recaptures all related device inventories and topologies when a
device is changed from the managed state to the unmanaged state. Avaya recommends that
you minimize such state changes.
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Chapter 4: Virtualization common icons

and procedures

The following icons and procedures are common to many activities.

AFO Virtualization application icons

The following table details the Virtualization application icons.

Y Online Help

H Device Management

a Network Discovery status information
B Distributed Switch Info

b Clear Highlights

8 Save topology

Clear Saved topology

ol

The number of data centers discovered by Virtualization

The number of ESX/ESXi hosts discovered by Virtualization

The number of VMs discovered by Virtualization

Indicates Virtualization is connected to the vCenter Server

’
@ Indicates Virtualization is disconnected from the vCenter Server
oY Indicates notifications present.
A Indicates no notifications present.
Table continues...
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Virtualization common icons and procedures

@‘ Of Refresh timer
C Refresh the visible pane
Y Filter option
h Clear Filter option
+ Add
Edit

Copy an existing network profile

= Delete

Filter Status: [0 Filter applied

A 4 No filter applied

v This option is available only in Event Monitor tab. If the action is in manual mode in the

Event Monitor tab, you can click this option to manually mark the action as complete.

Show or hide columns

In the Virtualization application, you can show or hide columns to better manage the overall quantity
of information. This functionality is available in Event Monitor, Network Profiles, Rules, and Audit
Log. In addition, you can sort the columns in ascending or descending order and filter the results.
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Filter information

Network Configuration Backup & Restore Reports Wiard Administration Too

Avaya Fabric Orchestrator

Topology Inventory Event Monitor Network Profiles Rules Reports Network Valida
Y % C Filter: None
Date/Time . Log L User Status Event ID Switch IP Message

| 2015-10-15 17:20:44  Sum._.. admin SUCCE. | Sort Ascending Next Audit Log purge sc
2015-10-15 17:20:44  Sum... admin SUCCE. | Sort Descending Next monitor purge sche
2015-10-15 17:15:01  Error admin FAILURE 5 Columns 1 Date/Time ~ 'led to establish conn
2015-10-15 17:14:56  Error admin FAILURE 3 Lt led to establish conn
2015-10-15 17:14:31  Error admin FAILURE . led to establish conm
2015-10-15 17:14:01  Error admin FAILURE Heer led to establish conni
2015-10-15 17:13:56  Error admin FAILURE Status led to establish conns
20151015 17:13:311  Emor  admin FAILURE A BventD i to establish conn
2015-10-15 17:13:01  Error admin FAILURE it P led to establish conni
2015-10-15 17:12:56  Error admin FAILURE 1 Message o4 to establish conni
2015-10-15 17:12:31  Error admin FAILURE Failed to establish conni
2015-10-15 17:12:01  Emor admin FAILURE Failed to establish conni

Figure 6: Show or hide columns

Filter information

Filters can be applied to sort and filter the information that displays. You can select conditions so
that only certain information displays.

You can filter information in Inventory, Event Monitor, and Audit Log.
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Virtualization common icons and procedures

Audit Log Filter X

Past: Select

From:

To:

Log level: = Select

User: Select

Status: Select

Event Id:  Enter a numeric value
Switch IP:

Message: Search for VM name/Event Type/Center Info

00 | ruse | O [@

Figure 7: Audit Log filter
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Chapter 5: CDP and LLDP settings
configuration

This chapter provides concepts and procedures to configure CDP and LLDP settings on .

Configuring CDP settings on the dvSwitch

Before you begin
Ensure that you have the administrative privileges to access the VM Network in vSphere Client.
About this task

Configure the Cisco Discovery Protocol (CDP) settings on dvSwitch to ensure proper connectivity
between the ESX server and the ERS Devices.

© Important:

You must configure the CDP settings both on the dvSwitch and on the vSwitch. For more
information, see Configuring CDP settings on the vSwitch on page 30.

Procedure
1. Launch the vSphere Client.
2. In the Inventory tab, click Networking.
3. In the left pane, right-click the dvSwitch to configure, and then select Edit settings.
The dvSwitch Settings window displays.
4. In the Properties tab, select Advanced.

5. In the Advanced section, under Discovery Protocol, configure the Status as Enabled and
the Type as Cisco Discovery Protocol.

6. In the Operation drop-down box, select either Advertise or Both.
7. Click OK.
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CDP and LLDP settings configuration

Configuring CDP settings on the vSwitch

Before you begin
Ensure that you have the administrative privileges to access the VM Network in vSphere Client.

About this task

Configure the Cisco Discovery Protocol (CDP) settings on the vSwitch to ensure proper connectivity

between the ESX server and the ERS Devices. You can change these settings using the ESX
server.

© Important:

You must configure the CDP settings both on the dvSwitch and on the vSwitch. For more
information, see Configuring CDP settings on the dvSwitch on page 29.

Procedure
1. Log in as Root.

2. To get the current CDP setting, type the following command: esxcfg-vswitch -b
<vSwitchName>, where <vSwitchName> is the name of the vSwitch through which you
configured VM traffic to flow.

The result of the command displays 1isten, advertise, or both, depending on the
configuration.

3. To change the mode to both or advertise, type one of the following commands: esxcfg-
vswitch -B both <vSwitchName>, or esxcfg-vswitch -B advertise
<vSwitchName>.

Configuring LLDP settings on the Avaya device

Configure LLDP on the Avaya device to send the following information to allow Virtualization to
discover the network:

* Chassis ID (enabled by default)
» Port ID (enabled by default)
* Management Address (must be manually enabled)

» Port Description (must be manually enabled)

© Note:

The following Avaya devices support LLDP:
* ERS 45xx / ERS 48xx
* ERS 5xxx
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Configuring LLDP settings on the Avaya device

+ VSP 7000

Procedure

1. Enable the Management Address to be published for specific ports:

store  Reports Wizard Administration Tools [P Flow  Virtualization

ups MNetworkTable VLAN MLT Routing VRF Multicast Fabric FabricExtend Multimedia Trap/Log Registration Security [EEl I (+ Ok - 3

10.133.139.102 *

VSP7000 - VSP 7024 <t | QY Device Physical View || ] Switch Summary = | £Z] LLDP =

TP @O Giobaks | Port || TuStaes || mxstam | LocalSystem | Local Part || LocaiManagement | Msghbor || Msighbor Momt Address

Seanch: x 2 2
v % Refresh | L Beopt Semt @b
43 Configuration

) Administration AddrSublype Addr AddrLen AddriiSubtype Addrifid AddrOD AddrPortsTaEnable

| Device ove 10.133.139.102 § unknown o 1.3.6.1.4.1.45.3.79.1(8reg-VSP-TO24XLS) =132
5 Edt

] Chasss
= Bridge
= File Sysiem
# 7] Diagrostics
T Port Wirrors
E1L2PnpA2Trace Roul
Eal=g]
] Tencigy
=] Systemlog
oo
4 3802148
] Port MED
= Avaya
TNt
2] SNTPiCiack

Launch EDM for the device on which LLDP is to be enabled.
On the Left Pane, navigate to Configuration > Edit > Diagnostics > 802.1AB.
Click LLDP.

On the right pane, click Local Management.

® & o0 T o

Select the ports to which ESX is connected and click Apply.
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CDP and LLDP settings configuration

2. Enable the device to send Port Description information for specific ports.

¢ RSN Backup & Restore  Reports  Wizard  Administration Tools  IP Flow  Virtualization

F
+ B
£

o8 Metwork Table VLAN MLT Routing WVRF Multicast Fabric Fabric Extend Multimedia Trap/Log Registration Security m 3]

10.132.139.102 *
VSPTO00 - VSP 7024 <! | G Device Physical View || [ Switch Summary
2 P E e Giobobs | Port | THStab || RiStals || LocaiSysten || LocalPurt | Local Menagement || Melghbor || Meighbor Momit Address krown TL Voomriirations Batied Tnio

Search: ® P ’
v Aoly | T Refresh Eport  (Sipmt @
# {5 Configuration i = fee
| Administration Mubtiple Port Configuration 2
Device - .
=t Make Selection
Switch/Stack/Ports:
Chassis =
=] Bridge AdmnGtatus MtifacationE nabie TLVETXEnabie TLVsTxEnabie{med) FatityEr
=51 Fiée System E
# (5 Diagnostics TLVsTxEnable x
= Part Mirmors
=] L2Pngh Trace Roul 7| portDese | | eysiame || sysDese | | syeCan ) ~ )
= CFu Disable Al Select Al Ok Close .mol\rsdﬁm”ckatsdecmn”mw | [ sihow non-Ediabe |
=] Topokogy
£ System Log = T e
= oo Porthum AdminStatus HotrficationEnable | TLVsTxEnable | TLWsTxEnable(med ) NotifyEnabiein
45802148 " AR false poriDesc syshame,sysDesc sysCap capabies, natworkPolcy location, mventary true
:-‘]EEP il beAndRx | tue | | poriDesc, syshame syslesc sysCap | capabiities, networkPalicy locaton, inventary frue
=] Port MED n txAndRs faise porDese syshame syaDese sysCap eapabities, natwirkPakicy leation nuentory true
2 I Avaya 14 beAndRx false poriliesc. syshame, sysDesc sysCap capabiities, natworkPolcylocation, inventory true
TP 1S beAndRx false poriDesc. sysHame, sysDesc sysCap capabiities, networkPolicy location inwentary frue

5 sHTRICiock

- & i 5
] Link State Tracking

Launch EDM for the device on which LLDP is to be enabled.

On the Left Pane, navigate to Configuration > Edit > Diagnostics > 802.1AB.
Click LLDP.

On the right pane, click Port.

© a0 T Qo

In the bottom pane, for the port that is connected to ESX, configure TLVs TxEnable as
PortDesc, NotificationEnable as true and AdminStatus as txAndRx.

f. Click Apply.

Configuring LLDP settings on the dvSwitch

Before you begin
Ensure that you have the administrative privileges to access the VM Network in vSphere Client.
About this task

Configure the Link Layer Discovery Protocol (LLDP) settings on dvSwitch to ensure proper
connectivity between the ESX server and the Avaya devices.

© Important:

You must configure the LLDP settings on the dvSwitch and on the Avaya device. For more
information, see Configuring LLDP settings on the Avaya device on page 30.

Procedure
1. Launch the vSphere Client.

2. In the Inventory tab, click Networking.
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© N o o b

Configuring the location and application type of the ESX server

In the left pane, right-click the dvSwitch to configure, and then select Edit Settings.
The dvSwitch Settings window displays.

In the Properties tab, click Advanced.

In the Advanced section, ensure that LLDP Status is enabled.

In the Type drop-down box, select Link Layer Discovery Protocol.

In the Operation drop-down box, select either Listen or Both (Listen and Advertise).
Click OK.

Configuring the location and application type of the ESX
server

Before you begin

Ensure that you have the administrative privileges to access the VM Network in vSphere Client.
About this task

Configure the Location and the ApplicationType of the ESX server to ensure proper functionality of
the ESX server within Virtualization.

Procedure

1.

Launch the vSphere Client.

2. In the Inventory tab, click Clusters.
3.
4

. In the Summary tab, under Annotations, click Edit.

In the left pane, select the ESX server to configure.

The Edit Annotations window displays.
Click Add.
The Add Custom Attribute window displays.

6. In the Add Custom Attribute window, enter the values for the Name, Value, and Type fields.
7. Click OK to close the Add Custom Attribute window.
8. Click OK ..
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Chapter 6: Managing Virtualization

The following sections provide the procedures for configuring and managing Virtualization.

vCenter connectivity status

The vCenter connectivity status displays the current vCenter server connectivity status and provides
an option to reconnect to the vCenter server. The status of the vCenter connection is indicated by a
red icon (disconnected) or green icon (connected) in the status bar information area. A dialog box
displays with a description of the connection status of the vCentre.

The notification icon is highlighted in the status bar during vSwitch and dvSwitch create and remove
operations.

Click Reconnect to reconnect to the vCenter server.

vCenter Server Connectivity Status

Connected: vCenter Server [10.133.139.64]
Status: Link Up (Active)

Figure 8: vCenter connectivity status dialog box

Network Discovery procedures

This section provides the Network Discovery procedures.

Viewing Virtualization Network Discovery status summary

When you start AFO Virtualization, an automatic inventory audit is performed followed by a
hypervisor connectivity operation.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 34
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Virtualization Inventory procedures

About this task
Perform the following procedure view a summary of the Virtualization Network Discovery status.
Procedure

1. From the AFO menu bar, select Virtualization > Topology or Virtualization > Inventory.

2. Click the Network Discovery icon on the Virtualization dashboard.

The Virtualization Network Discovery Status window displays.
3. Click Refresh to manually refresh the screen.
4. Click Close.

Viewing Hypervisor Connectivity information

After the Network Discovery is complete, you can view the entire network connectivity of the virtual
machines in the data center. Hypervisor connectivity is automatically performed every 24 hours by
default to ensure that any changes in the network setup are captured. You can reschedule the
hypervisor connectivity schedule interval using the Preferences icon on the Avaya Fabric
Orchestrator (AFO) quick toolbar. For more information on configuring Virtualization preferences,
see Administration using Avaya Fabric Orchestrator, NN48100-600.

About this task
Perform the following procedure view the Virtualization Hypervisor Connectivity information.
Procedure

1. From the AFO menu bar, select Virtualization > Topology or Virtualization > Inventory.

2. Click the Network Discovery icon to display a summary of the Virtualization Network
Discovery Status.

The Virtualization Network Discovery Status window displays.

3. Click Details in the Hypervisor Connectivity section of the Summary tab.

Virtualization Inventory procedures

This section provides the Virtualization Inventory procedures.

Viewing Inventory information

About this task
Perform the following steps to view the Virtualization Inventory information.
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Procedure

1. From the AFO menu bar, select Virtualization > Inventory.

2. Select Hypervisor or Virtual Machine from the View drop-down menu.

Field descriptions

Field

Description

Hypervisor Inventory

Hostname/IP Address

IP Address of the host server.

Location

Location of the server. Provided as an attribute on
the ESX/ESXi server.

Monitor Events

Opens the Event Monitor tab.

Statistics

Number of Virtual Machines (VM) and Network
Interface Cards (NIC).

Virtual Machine

VM Name

Name of the Virtual Machine.

Hostname/IP Address

Name/IP Address of the Host server.

Application Type

Application server type of virtual machine. Provided
as custom attribute in the VM by the user.

Monitor Events

Number of events being monitored.

Tenant Name

Name of the Tenant.

Viewing Inventory Audit information

Inventory audit captures the topology of the datacenter. The Inventory audit information ensures that
Virtualization captures important information, such as all data centers, clusters, ESX servers, virtual
machines, and related Vswitches/Dvswitches, PortGroups. Each time you start the Virtualization
application, an inventory audit is automatically performed to capture this information and keep
Virtualization updated. vCenter server details and credentials are found in the Virtualization

Preferences Global tab on the menu bar.

About this task

Perform the following procedure view the Virtualization Inventory Audit information.

Procedure

1. From the AFO menu bar, select Virtualization > Topology or Virtualization > Inventory.

2. Click Network Discovery icon to display a summary of the Virtualization Network Discovery

Status.

The Virtualization Network Discovery Status window displays.

3. Click Details in the Inventory Audit section of the Summary tab.
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Event Monitor procedures

Filtering Inventory

Virtualization Inventory provides a filter option to search for information by fields. The filter can be
based on a single field or combination of multiple fields.

About this task

Perform the following procedure to filter the Virtualization Inventory information.

Procedure

1.
2.

o o bk~ w

From the AFO menu bar, select Virtualization > Inventory.

Select Hypervisor or Virtual Machine from the View drop-down menu to view the
Virtualization Inventory information.

Click the Show Filter icon.

Enter the filter options in the filter window.

Click Apply.

(Optional) Click the Clear Filter icon to clear the applied filters.

Event Monitor procedures

This section provides the Event Monitor procedures.

Viewing Event Monitor information

Event Monitor displays a list of each transaction that occurs within the vCenter server. After you
create a virtual machine, it is sent through the network from vCenter to Virtualization. The monitor
displays the attributes of this creation, if the addition of the virtual machine was either successful or
partially successful, and if the creation failed or is in a pending state.

About this task

Perform the following steps to view the Virtualization Event Monitor information.

Procedure

1.

From the AFO menu bar, select Virtualization > Event Monitor.

The Event Monitor window displays.

2. (Optional) Click the Refresh icon to refresh the view.

Event Monitor field descriptions

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 37

Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Managing Virtualization

Field Description

Event Type The event type from the vCenter.

Event Name The event name from the vCenter.

VM Name The name of the virtual machine.

Action Insert a description of this field. Type of action that
occurred within the vCenter in AFO Virtualization. If
the result of the Action is Auto, then the status is
automatically delivered. If an Action is in a Manual
mode, the event is either in a pending, partial
success, or failed state.

Status Displays the status of the given event, which can be
either success, pending, or failed.

VLAN ID Number of the VLAN.

Rule Displays the rule associated to the event.

Network Profile The associated network profile of the event.

Timestamp Date and time at which the event occurred.

Viewing Applied Configurations pane

The Applied Configurations pane displays a list of successful configuration changes on the various
devices. You can view these configuration changes by selecting a specific event from the Event
Monitor pane. If the event configuration is successful, the given event from the Monitor Events pane

is populated in the Applied Configurations pane.

The following table describes the content of the Applied Configurations pane.

Field Description

Action The name of the operation that was performed on
the device.

Switch IP IP address of the switch.

Parameter Associated parameter.

Message Displays the details of the configuration changes.

Timestamp The date and time at which the configuration
occurred on the switch.

Viewing Pending/Failed Actions pane

The Pending/Failed Actions pane displays a list of pending or failed configurations on the devices. If
an action is pending or failed, an explanation appears in the message column. The status of an
action is pending if there is no rule matching the VM event or if the matching rule is manual. If the
pending action is a result of irrelevant or missing information, you can review the data and manually

confirm the status if required.

December 2016

Virtualization Configuration using Avaya Fabric Orchestrator 38
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

© Note:

Event Monitor procedures

If the action of the event in the Event Monitor pane is in Manual mode and the status of the
action in the Pending/Failed Actions pane is pending, you can mark the action as manually

completed.

The following table describes the content of the Pending/Failed Actions pane.

Field Description

Action The type of action that is either pending or failed.

Switch IP IP address of the switch.

Parameter The associated parameter.

Status Indicates if the action is pending, partial success, or
failed.

Message Displays the reason for which the action is either
pending or failed.

Timestamp The date at which the action occurred.

Filtering Event Monitor
About this task

Perform the following steps to apply the Filter option to the VM events that have occurred on a

particular ESX/ESXi server.

Procedure

1. From the AFO menu bar, select Virtualization > Event Monitor.

The Event Monitor window displays.

2. Click Filter.

The Events Filter window displays.
3. Select the options to filter.
4. Click Apply.
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Example

AUdIT LOgS MOMTONNg Heporis LHSCOVEry Heporis

] Filter Status

Events Filter

Datacenter Name:

Server Name:
VM Name:
Event Type:
Status:
Action:

VLAN Id:
Rule:

Metwork Profile:

Select

Enter a Server Name
Enter a VM Name
Select

Select

Search for Action
Enter a numeric value

Select Rule

Select Network: Profile

Click Clear Filter to clear the applied filters and restore all the records in the table.

Grouping information by fields

Related information can be viewed in adjoining rows.

© Note:

You can group information by fields for Event Monitor only.

Procedure

1. Select the desired field.

2. Click Group By This Field in the list.
Example

The following figure shows the fields grouped in rows.
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Network Profiles procedure

T TR Lo T i TR S8 e - - - -~

Scheduler File Inventory  Device Software Management

Y Filter Status: ¥ (' & of
Event Type EventM... WM Mame Action Status | VLA .. Rule Metwork Pro... Timestamp
| Sort Ascending
| Sort Descending

| Columns

=| Group By This Field

["] Show in Groups

To ungroup the fields, clear the Show in Groups selection.

Network Profiles procedure

This section provides the Network Profiles procedures.

Network configuration is simplified by providing a template called network profile for defining
configuration parameters and which are used across the device types. Because Virtualization
responds to lifecycle changes of VMs in the datacenter, network profiles can be used to define
device configurations to be performed.

Use the network profiles to define the VLAN and port configurations that are applied to a switch port.
A network profile provides a view of the VLAN, bandwidth, metering, access control and QoS
configuration and ensures that the trunk is correctly configured to support the VM traffic. After you
define and save a set of configurations, if a change occurs on the datacenter, the network profile is
applied to the corresponding data switch in the network to support this change.

The following image shows the Network Profiles table.

Topology 'n\-'entcry Event Monitor Rulas. Reports Aucit Logs Natwork Validation Device Management | + ? ﬁ
The following table details the attributes for the profiling table.
Attribute Description Range Default value
Sino Serial number Numeric —
Profile Name Name of the profile Mandatory field. —
Maximum 13
characters
Table continues...
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Attribute

Description

Range

Default value

Service ID [I-SID]

Service ID of the profile

Contains between 1
and 1677214

Group information

Numeric between 1
and 64

characters
Service ID [I-SID] Prefix Service ID prefix of the — —
profile
STG Information The Spanning Tree Mandatory field. 1

QoS Level

Number of the QoS

Mandatory field.
Numeric between 0
and 7

Last Modified Time

Date and time at which
the profile was last
updated

Adding a profile

About this task

You must add a profile to properly commission Virtualization. You can use profiles to create a

definition that you want to send to the server.

Procedure

1. From the AFO menu bar, select Virtualization > Network Profiles.
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Network Profiles procedure

2. Click the + sign on the Network Profiles tab. The Add Profile window displays.

Add Profile

Profile Name

VLAN Configuration

m

8TG
Configure different setting for the Edge and Core Device

Edge And Core

General
QoS Lavel 0 High Priority
1K)
Senvice Configuration &
Configure L2V/SN with Switched UNI: |
Semnvice ID Type I-SID Senice ID 0
[I-SID]
Traffic Profile/ACL Configuration (Optional)
[ Stackable Type
Protocol 255 Action Drop
Action Set Committed Rate
Frecedence
| Modular Type
Priority tepSrcPort
Ace Mode udpSrcPort

Peak Rate tepDstPort =
Qsae  Qciose  @He

3. Type the information in the applicable fields. Ensure the mandatory fields are complete, such
as Profile name, VLAN ID, and STG Id. You can also choose to select the Configure
different setting for the Edge and Core Device check box.

© Note:

After you add a new profile, you cannot edit the Profile name, VLAN ID, and the STG ID.
Determine whether frames in this VLAN should be assigned a high switching priority by
selecting High Priority (1K).
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Q Tip:

The Traffic Profile/ACL Configuration section is optional. Use this section to configure
a device port to allow or drop traffic that meets the specified criteria. For example,
Ethernet Routing Switches (ERS) 45xx, 55xx, and 56xx are stackable devices, whereas
ERS 86xx and 88xx are modular devices. If you add a network profile without configuring
the Traffic Profile/ACL, only the VLAN configuration is applied to the network device.

4. Click Save.

The following table describes the values for adding a profile.

Value Variable

Profile Name Name of the profile. Mandatory field.
VLAN Configuration
Configure different setting for the Edge | Configures different setting for the Edge and Core Device

and Core Device when check box is selected.

STGID The Spanning Tree Group ID.

Edge And Core ID Specifies different STG IDs for edge and core devices
when provisioning the physical network for a VM event.

QoS Level Selects a Qos level from the available options. The
default value is 0.

High Priority (1K) A flag to note whether frames in this VLAN should be
assigned a high switching priority.

Configure L2VSN with Switched UNI Configures L2VSN with Switched UNI when check box is
selected.

Service ID [I-SID] [-SID used to provision a Service (L2 VSN Service) on an
UNI either as CVLAN or a Switched mode.

Service ID Type [I-SID] Use the Service ID [I-SID] provided by the user in the

network profile to configure the actual I-SID.
Traffic Profile/ACL Configuration (Stackable Type)

Protocol Protocol is the ipv4 protocol number [0..255]; 1(icmp-
ipv4), 2(igmp), 6(tcp), 17(udp), 46(rsvp), 58(icmp-ipv6).

Action Drop Action to be Performed, Drop or Pass.

Action Set Precedence The precedence for the Classifier Filter Set.

Committed Rate (kbps) Committed rate is integer value [0..10230000] in multiples
of 64 or 1000.

Traffic Profile/ACL Configuration (Modular Type)

Priority Priority for ACE.

Ace Mode Mode of ACE.

Peak Rate (kbps) Peak Rate in kb/s [1000-10000000].

tcpSrcPort Comma separated list of ports: {0..65535} in ascending
order.

Table continues...
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Value Variable

udpSrcPort Comma separated list of ports: {0..65535} in ascending
order.

tcpDstPort Comma separated list of Port: {0..65535} in ascending

order or {echo, ftpdata, ftpcontrol, ssh, telnet, dns, http,
bgp, hdot323}.

udpDstPort Comma separated list of Port: {0..65535} in ascending
order or {echo, dns, bootpServer, bootpClient, tftp, rip, rtp,
rtcp}. This content is case sensitive.

Editing a profile
About this task

You can edit an existing profile from the Network Profile service. Perform the following procedure to
edit a profile.

© Note:

Avaya recommends that you do not edit a profile that already applies to a device. You can still
edit the selected profile; however, a warning message appears stating that you are editing an
already applied profile.

Procedure
1. From the AFO menu bar, select Virtualization > Network Profiles.

2. Select the profile you want to edit.

© Note:

You cannot edit the Profile Name, STG ID, VLAN ID and Service ID [I-SID] of an already
existing profile.

3. On the Profiles tab, click the Edit an existing network profile icon.
The Edit Profile window appears.

4. Edit the content you want to change in each appropriate field.

5. Click Save.

Deleting a profile

About this task

You can use the delete option in the Network Profile service if you no longer need a specific profile.
Perform the following procedure to delete a profile from the list of existing profiles.

December 2016 Virtualization Configuration using Avaya Fabric Orchestrator 45
Comments on this document? infodev@avaya.com



mailto:infodev@avaya.com?subject=Virtualization Configuration using Avaya Fabric Orchestrator

Managing Virtualization

© Note:

You cannot delete a profile if a rule or a device is associated with the profile or if this is the last
profile having a particular VLAN Id and there is any VLAN I-SID VId entry with the same VLAN
Id. If you try to delete the profile, an error message appears and the deletion fails.

Procedure
1. From the AFO menu bar, select Virtualization > Network Profiles.
2. Select the profile you want to delete.
3. On the Profiles tab, click the Delete an existing network profile icon.

4. In the Delete Profile window, click Yes.

Rules management

You can simplify configurations by using rules. Rules are conditions that apply to network profiles to
determine which of these network profiles apply to which virtual machine (VM) event. When a VM is
migrated, Virtualization receives that VM event from the vCenter server and supports the migration

by sending the configuration to the data center switch. You can apply a maximum of five criteria for
each rule you create, with each of the criteria being based on the following three options:

* Location—The value of the custom field, Location of the ESX/ESXi host on which the VM is
hosted or being migrated to.

* VM Application Type—The application server type of the virtual machine.

» Port Group (VLAN ID)—The VLAN ID of the port groups to which a virtual machine is
connected.

» Port Group (Name)—The name of the port group to which a virtual machine is connected.

A rule is either configured as automatic or manual. In the case of an automatic rule, if a match is
found for a virtual machine event, then the configuration defined in the related network profile is
applied on the device of the physical network. As for a manual rule, the configuration defined in the
associated network profile is not automatically applied to the network devices, in which case you
can use the Dashboard to manually mark the configuration as completed by the operator.

Virtualization cannot choose between more than one applicable rule.

© Note:

Avaya recommends that you configure rules during the Virtualization setup process to enable
proper functionality.

The following figure shows the Rules table:
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MNetwork Configuration Backup & Restore Reports Wizard Administration Tools [P Flow RUTENTs1alel]

Avaya Fabric Orchestrator

Topology Inventory Event Monitor  Network Profiles m Reports  Audit Logs Network Validation  Device Management E =+ [ ? -b
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B Sho | Name Type Condition Start Time End Time Network Profile Last Updated

Figure 9: Rules table
The following table lists the details of the tabs in the Rules table.

Field Description

Slno The row number of the rule.

Name The name of the rule.

Type The type of rule, either manual or auto. If manual is applied, the action is only in

a proposed state. If auto is applied, the configurations are applied to the
appropriate switch.

Condition The condition attributed to the rule.

Start Time Start time of the interval when this rule can be applied.
End Time End time of the interval when this rule can be applied.

Network Profile Name of the network profile.

Last Updated The date and time at which the rule was last updated.

Adding a rule

About this task

You can add a rule to apply specific conditions to a VM event to select the network profile which is
applied to the data switch. After you add a rule, each rule that applies to a specific network profile is
populated in the Monitor pane where you can view and monitor the status of those events.

Perform the following procedure to add a rule.
Procedure
1. From the AFO menu bar, select Virtualization > Rules.
Click the + sign on the Rules tab. The Add Rule window displays.
In the Name field, type the name of the rule.

In the Network Profile drop-down box, select a network profile for the given rule.

o & w0 N

(Optional) Select Automatic to automatically configure the rule of the selected network
profile.

6. In the Effective Time area, type the start time and end time at which you want to begin and
end the given rule.

7. In the Condition Criteria section, select the conditions to apply to the given rule.

8. Click Save, and then click Close.
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Variable Description

Name Name of the rule.

Network Profile Select the appropriate network profile for the
given rule.

Automatic Enables automatic configuration of the rule. If

you disable the Automatic option, the rule is set
to manual. If you want the rule set to manual,
you can review the information before you apply
the configuration in the Pending/Failed Actions

pane.
Start Time The time at which the rule begins to apply.
End Time The time at which the rule ends.
Condition criteria Use this section to apply conditions to the given

rule. Select the appropriate criteria from the
available drop-down boxes. You can add a
maximum of five conditions.

Editing a rule
About this task
Perform the following procedure to edit a rule.
Procedure
1. From the AFO menu bar, select Virtualization > Rules.
2. Select the rule you want to edit.
3. On the Rule tab, click the Edit button.
The Edit Rule window appears.
4. Edit the content you want to change in each field.
5. Click Save.

Deleting a rule

About this task

You can delete a rule that you no longer require within Virtualization. Perform the following
procedure to delete an existing rule.

Procedure
1. From the AFO menu bar, select Virtualization > Rules.

2. Select the rule you want to delete.
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3. On the Rules tab, click the Delete button.
The Delete Rules window appears.

4. Click Yes in the Delete Rules window.

Reports management

This section provides information about the various reports you can generate.

Reports management tasks can be performed in Virtualization > Reports. If you want to generate
a report to include only a specific time period, you can define that time period by configuring the
criteria in the reports table.

Avaya Fabric Orchestrator  INetwork  Configuration  Backup & Restore  Reports  Wizard Administration Tools  IP Flow

Topology Inventory Event Monitor Network Profiles Rules BErGEhlesell Audit Logs Network Validation Device Manageme

Report Type VM topology
Criteria VM topology
Applied configurations
From Dat : L .
3 Pending/Failed actions
To Dat

& Generate Report ll  Reset

Figure 10: Reports view

VM topology reports

The VM topology report allows you to view the end-to-end topology information of the virtual
machines.

The VM topology report displays the following information from the device inventory.

Field Description
Data Center Name of the data center applied to the report.
Server Name of the server.
Location Location of the server.
Table continues...
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Field

Description

VM

Name of the virtual machine.

VM Application Type

The type of virtual machine that is used in the report.

Switch (v/dv)

The name of the virtual switch or the distributed
virtual switch.

Type The discovery protocol type, for example, CDP or
LLDP, on the virtual switch.

Status The discovery protocol status, for example, enabled
or disable.

Operation The discovery protocol operation can be BOTH or

LISTEN.

Port Group (v/dv)

The name of the virtual port group or the distributed
virtual port group.

Port Group VLAN ID

The number of the port group or the VLAN.

VM Adaptor

The network adaptor of the VM.

Uplink (v/dv)

The name of uplink ports of the virtual switch or the
distributed virtual switch.

Physical Adaptor

The name of the physical adaptor.

Switch IP The IP address of the switch to which the VM/ESX/
ESXi is connected.
Slot/Port The slot or port info of the switch.

Applied configurations reports

The Applied configurations report provides information about successfully applied configurations on
the physical network, or devices, for VM events during a specific period.

The Applied configurations report displays the following information from the device inventory.

Field Description

Sl.No. Switch slot number.

Event The name of the event used in the report.

VM The name of the virtual machine.

VLAN ID The number of the VLAN

Action The type of action that applied to the network.
Rule The rule that applied to the network profile.

Network Profile

The network profile associated with the rule.

Status The status of the event. Status can be success,
pending, or failed.
Timestamp The date and time when the event occurred.
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Pending or Failed actions reports

The Pending/Failed actions report provides information about the pending or failed actions on the
network. You can also view the actions that failed when you try to match a network profile.

The Pending/Failed actions report displays the following information from the device inventory.

Field Description

SI.No. Switch slot number.

Event The name of the event used in the report.

VM The name of the virtual machine.

VLAN ID The number of the VLAN

Action The type of action that applied to the network.

Rule The rule that applied to the network profile.

Network Profile The network profile associated with the rule.

Status The status of the event. Status can be pending, or
failed.

Timestamp The date and time when the pending or failed report
occurred.

Generating a report
About this task

You can generate a report to view data that stems from configurations and topology that occurs
within Virtualization. Complete the following procedure to generate one of the following types of
reports.

* VM topology
» Applied configurations
» Pending/Failed actions
Procedure
1. From the AFO menu bar, select Virtualization > Reports.
2. In the Reports tab, in the Report Type field, select the type of report you want to generate.

3. In the Criteria section, enter the appropriate time frame for which you want to view the
specific data.

© Note:

This step does not apply to the VM topology report.
4. Click Generate Report.
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Exporting data from a report

About this task

You can export data from a report to your computer for reference. Perform the following procedure
to export data from a report.

Procedure

1.
2.
3.

From the AFO menu bar, select Virtualization > Reports.
On the Reports tab, in the Report Type field, select the type of report you want to view.

In the Criteria section, enter the appropriate time frame for which you want to view the
specific data.

4. Click Generate Report.

5. Click the Export Data icon on the Report.

The Export Data window appears.

6. In the Available result sets field, select the appropriate option for the selected report.

7. In the Available Columns area, select the type of columns that you want to export from the

given report, and then click the Add all/Add icon to import the selected columns in the
Selected Columns area.

8. In the Export format field, select the format in which you want to view the data.
9. Select the Output encoding.
10. In the Separator field, select the type of separator you want to use.
11. Select either Export column's data type or Export column as locale neutral.
12. Click OK.
Variable Value
Available result sets The list of available viewable options
Available columns The list of columns that are available to view
Selected columns The list of columns that contain the data that you
select to export
Export format The format in which you want to view the
exported data. The format defaults to .csv.
Output encoding « UTF-8:
+ Other (If blank, use the local encoding)
Separator The type of separator you want to use to export
the data.
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Exporting a report
About this task

You can export report to your computer for reference. Perform the following procedure to export a
report.

Procedure
1. From the AFO menu bar, select Virtualization > Reports.
2. On the Reports tab, in the Report Type field, select the type of report you want to view.

3. In the Criteria section, enter the appropriate time frame for which you want to view the
specific data.

4. Click Generate Report.
5. Click the Export Report icon on the Report.
The Export Report window appears.
6. In the Export format drop-down list, select the format type to export the report.
7. Select the desired page option for exporting.
8. Click OK.

Printing a report
Before you begin

You must generate a report or access an existing report. For more information about generating a
report, see Generating a report on page 51.

About this task

After you generate a report, you can print the report to store a hard copy of the data. Perform the
following procedure to print a report.

Procedure
1. Click the Print icon on the Report.
The Print Report window appears.
2. Select the Print Format,HTML or PDF.
3. Select the desired page option for printing.
4. Click OK.
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Printing a report on the server

Before you begin

You must generate a report or access an existing report. For more information about generating a
report, see Generating a report on page 51.

About this task

After you generate a report, you can print the report to the server for future reference. Perform the
following procedure to print a report to the server.

Procedure
1. Click the Print report on the server icon on the Report.
The Print report on the server window appears.
2. Select the appropriate values for printing.
3. Click OK.

Audit Logs

All of the managers including Topology and Discovery send log messages to audit and debug logs.
You can use Virtualization > Audit Logs to view details about configuration changes that occurred
within Virtualization, such as the inventory audit or port scan, as well as the status of these
operations, and the processing of these events.

AFO Virtualization debug logs are located at <COM HOME>\vps\log\vps debug.log. You can
access the audit log preferences through the Preferences icon on the AFO menu bar.

You can generate Virtualization audit logs with the help of the logging service in Configuration. A
refresh icon is available in the Audit Log tab to view the most recent audit logs within Virtualization.
To differentiate Configuration from Virtualization, Virtualization audit logs are preceded by
Virtualization.

The following figure shows an example of Audit Logs.
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Avaya Fabric Orchestrator  IN€twOrk  Configuration Backup & Restore Reports Wizerd Administration Tools [P Flow JRGVElk{

Topology Inventory Event Monitor Network Profiles Rules Reports RENGIARGCE MNetwork Validation  Device Management

Y % ' Filter: None

2015-10-26 00:00:00 Summary admin SUCCESS License Check Complete. Current License Validity - true
2015-10-26 00:00:00 Summary  admin SUCCESS License Check Complete, Cument License Validity - true
2015-10-26 00:00:00 Summary  admin SUCCESS License Check Complete, Current License Validity - true
2015-10-25 00:00:00 Summary  admin SUCCESS License Check Complete, Current License Validity : true
2015-10-25 00:00:00 Summary admin SUCCESS License Check Complete, Current License Validity : true
2015-10-25 00:00:00 Summary  admin SUCCESS License Check Complete, Current License Validity : true
2015-10-24 00:00:00 Summarv  admin SUCCESS License Check Comolete. Cument License Validitv - true

Figure 11: Audit Logs view

Configuring Logging settings

You can configure settings for Audit Log Configuration and Debug Log Configuration. Click the
preferences icon from the quick access toolbar to open the Preferences page.

Configuring Audit Log
About this task
Perform the following steps to configure Audit Log settings.
Procedure
1. On the Preferences page, click Virtualization from the left navigation pane.
The Preferences page displays the Virtualization on the right side of the page.
2. Click the Logging tab.
The Logging pane is displayed.
3. In the Audit Log Configuration section, configure the following settings:

* In Level field, select On or Off from the drop-down list.
 Select or clear Enable Purge check box, to enable or disable purge.

* In Retention Time in Days [15-120] field, specify the number of records in days you
want to purge. The default value is 60.

4. Click Apply.

Configuring Debug Log
About this task
Perform the following steps to configure Debug Log settings.
Procedure
1. On the Preferences page, click Virtualization from the left navigation pane.

The Preferences page displays the Virtualization on the right side of the page.
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2. Click the Logging tab.
The Logging pane is displayed.
3. In the Debug Log Configuration section, configure the following settings:
* In File Size field, enter the maximum file size. The default value is 10 MB.
* In Level field, select Off, Error, Warn, Info, or Debug log level from the list.
The defaultis Info.
* In No. of Files [1-10] configure the number of log files. The default value is 3.
4. Click Apply.

Viewing Audit Logs
Perform the following procedure to view and refresh the audit logs.

Procedure
1. From the AFO menu bar, select Virtualization > Audit Logs.
2. Click the Refresh icon on the Audit Logs tab to refresh the audit log.

Filtering Audit Logs
Perform the following steps to apply the Filter option to search for information by fields.
Procedure
1. From the AFO menu bar, select Virtualization > Audit Logs.
The Audit Log window displays.
2. Click Filter.
The Audit Log Filter window displays.

3. Select the options to filter.
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2015-10-23 20:39:55 De  Switch IP:
s = Message:  Search for VM name/Event TypeivCenter Info
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2015-10-23 06:40:15 Su m
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4. Click Apply.

5. Click Clear Filter to clear the applied filters and restore all the records in the table.

Network Validation procedures

The following sections provide the Network Validation procedures.

Running Network Validation Report
About this task

Perform the following procedure to run a Network Validation Report.
Before you begin
» Configure vCenter Server settings
» Perform Inventory audit and hypervisor connectivity operation
Procedure
1. From the AFO menu bar, select Virtualization > Network Validation.
The Network Validation Report displays.
2. (Optional) Select Run Network Validation Report to rerun a Network Validation Report.
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Running network validation tab field descriptions

Field Description

VM Name Name of the Virtual Machine
Host Name Name of the Esxi server

NIC Name Name of the physical adapter
Virtual Switch Name of the virtual Switch
Network Label Name of the Port Group

PG Vianid Port group Vlan-ID

Device IP IP Address of the device
State State of the physical network
Error Msg Error message

Filtering Network Validation Report
About this task

Perform the following procedure to filter the Network Validation Report based on the network type.
Procedure
1. From the AFO menu bar, select Virtualization > Network Validation.
The Network Validation Report displays.
2. Select Apply Network Validation Report Filter.
The Network Validation Report Filter dialog box displays.
3. Select the appropriate parameters for filtering.
4. Click Apply.
The filtered Network Validation report displays.

5. (Optional) Select Clear Filter to clear the applied filters and to restore all the records.

Device Management procedures

This section provides the Device Management procedures.
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Viewing the Device Management status
About this task
Perform the following procedure to view the Device Management status.
Procedure
1. From the AFO menu bar, select Virtualization > Device Management.
The Device Management window displays.
2. Select the desired option in the View field to view the device status.
3. (Optional) Click the Refresh icon to manually refresh the screen.

4. Click Save Device Management State icon to save.

Managing devices
About this task

You can manually select devices that are in an unmanaged state within the Device Management

window to become managed. Although you can perform this task manually, moving a device from
the managed to unmanaged state causes the Virtualization application to recapture all the related
inventories and topology of the device. Avaya recommends that you minimize such state changes.

You can also manage or unmanage stacked units under the Stack Units tab. Perform the following
procedure to manage or unmanage a device.

Procedure
1. From the AFO menu bar, select Virtualization > Device Management.
The Device Management window displays.
2. Determine the device state to be changed.
3. To manage or unmanage a device, click the State cell of the selected device row.
A check box displays.

« if the check box is selected, the device is managed. Click the box (the check mark
disappears) to unmanage the device.

« if the check box is not selected, the device is unmanaged. Click the box (a check mark
appears) to manage the device.

* If a stackable device, you can manage or unmanage stack units using the Stack Units tab.

Unsaved changes of state are indicated by the red marks in the top left corner of the State
cells.

4. (Optional) Click the Refresh icon to review the current device states.
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5. Click the Save Device Management State icon to save the changes to the device States.
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Chapter 7: Virtualization backup and
restore

The Virtualization database table is the repository of the data that Virtualization updates during
backup or recovery. The backup operation makes a backup of the Virtualization system along with
Configuration and SMGR to create restoration files in the event that the system state becomes
corrupted. Virtualization automatically updates the database tables during a combined backup of
Configuration and Virtualization while using scripts for Windows and Linux. You can then restore the
system back to the checkpoint created by the backup file.

© Note:

Avaya recommends that you backup Configuration along with the Virtualization application.

Virtualization database tables

The Virtualization application has both configured user/system and system discovered data. The
following is the list of information that the system or users configures:

* Network profile
* Rules
* Virtualization managed device
« Virtualization historical event information
The Virtualization properties file is found in the following area:
{$JBOSS HOME}/server/avmgmt/conf/vps/VpsPreferences.properties

The following table contains a list of database tables that corresponds to the Virtualization during
backup:

Table 2: Database tables

Database table

eem_vps_vnds_uplink eem_vps_portgrp_vndsport

Table continues...
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Database table

em_vps_serverinfo_vnds

eem_vps_vnic

eem_vps_linkinfo

eem_vps_physicaladaptor

eem_vps_portgroup

eem_vps_vnd_switch

eem_vps_vminfo

eem_vps_serverinfo

eem_vps_clusterinfo

eem_vps_datacenterinfo

eem_vps_rule_variable_condition

eem_vps_rule_variable

eem_vps_rule_condition

eem_vps_rule

eem_vps_networkprofile

eem_vps_monitor_event

eem_vps_monitor_appliedconfig

eem_vps_monitor_action

eem_vps_monitor

eem_vps_device_unit

eem_vps_device

eem_vps_applied_vm_profile_switch

eem_vps_preferences

eem_vps_preferences_element

eem_vps_audit_log

eem_vps_topology_edge

eem_vps_topology_geometry

eem_vps_topology_vertex

eem_vps_vcenterinfo
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Chapter 8: Resources

Support

Go to the Avaya Support website at http://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Training

Ongoing product training is available. For more information or to register, you can access the Web
site at http://avaya-learning.com/.

Viewing Avaya Mentor videos

Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya
products.

About this task

Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure

» To find videos on the Avaya Support website, go to http://support.avaya.com and perform one
of the following actions:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.
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Resources

* To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and
perform one of the following actions:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos posted
on the website.

© Note:

Videos are not available for all products.

Documentation

The following table lists the documents related to this product. Download the documents from the
Avaya Support website at http://support.avaya.com.

Document title Use this document for: Audience
Avaya Network Management Description of each verified System administrator
Solution Description, NN48100— reference configuration.
100
Deploying Avaya Fabric Installing, configuring, initial System administrator
Orchestrator, NN48100-101 administration, and basic

maintenance checklist and

procedures.

Getting Started and Locating the Locating the latest software and System administrator
latest software and Release Notes | product release notes.
for Avaya Fabric Orchestrator,
NN48100-102

Network Monitoring using Avaya Monitoring the managed obijects. System administrator
Fabric Orchestrator, NN48100—

500
Network Configuration using Configuring and managing Avaya | System administrator
Avaya Fabric Orchestrator, Enterprise family of devices from
NN48100-501 discovered network.
Bulk Device Configuration Performing a variety of System administrator
Management using Avaya Fabric | management tasks across multiple
Orchestrator, NN48100-502 device types using a web-based
interface.
Virtualization Configuration using | Connecting the vCenter server to | System administrator
Avaya Fabric Orchestrator, the system, to help the data center
NN48100-503 administrator to configure the

network changes that apply to the
data center.

Table continues...
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Searching a documentation collection

Document title

Use this document for:

Audience

IP Flow Configuration using Avaya
Fabric Orchestrator, NN48100—
504

Collecting and analyzing IP flows
from IPFIX-, NetFlow v5-, and
NetFlow v9- enabled devices.

System administrator

Administration using Avaya Fabric
Orchestrator, NN48100-600

System administration procedures.

System administrator

Avaya Network Management
Traps and Trends Reference,
NN48100-700

Viewing a list of supported traps
and trends.

System administrator

Avaya Network Management
Supported Devices, Device MIBs,
and Legacy Devices Reference,
NN48100-701

Confirming support for devices
and MIBs.

System administrator

Troubleshooting Avaya Fabric
Orchestrator, NN48100-702

Troubleshooting information for
the system.

System administrator

December 2016

Searching a documentation collection

On the Avaya Support website, you can download the documentation library for a specific product
and software release to perform searches across an entire document collection. For example, you
can perform a single, simultaneous search across the collection to quickly find all occurrences of a
particular feature. Use this procedure to perform an index search of your documentation collection.

Before you begin

* Download the documentation collection zip file to your local computer.
* You must have Adobe Acrobat or Adobe Reader installed on your computer.

Procedure

1. Extract the document collection zip file into a folder.

2. Navigate to the folder that contains the extracted files and open the file named
<product_name_release>.pdx.

3. In the Search dialog box, select the option In the index named
<product_name_release>.pdx.

4. Enter a search word or phrase.

5. Select any of the following to narrow your search:

* Whole Words Only
» Case-Sensitive

* Include Bookmarks
* Include Comments

6. Click Search.
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Resources

The search results show the number of documents and instances found. You can sort the
search results by Relevance Ranking, Date Modified, Filename, or Location. The default is
Relevance Ranking.

Subscribing to e-notifications

Subscribe to e-notifications to receive an email notification when documents are added to or
changed on the Avaya Support website.

About this task

You can subscribe to different types of general notifications, for example, Product Correction
Notices (PCN), which apply to any product or a specific product. You can also subscribe to specific
types of documentation for a specific product, for example, Application & Technical Notes for Virtual
Services Platform 7000.

Procedure

1. In an Internet browser, go to https://support.avaya.com.

Type your username and password, and then click Login.
Under My Information, select SSO login Profile.
Click E-NOTIFICATIONS.

In the GENERAL NOTIFICATIONS area, select the required documentation types, and then
click UPDATE.

o & 0N
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Subscribing to e-notifications

GENERAL NOTIFICATIONS

i/5 MNotifications Selectad

-,-'l L

End of Sale and for Manufacturer Support Notices
Product Correction Notices (PCN) o
Product Support Notices

Security Advisories

Services Support Notices

UPDATE »

6. Click OK.
7. In the PRODUCT NOTIFICATIONS area, click Add More Products.

PRODUCT NOTIFICATIONS Add More Products

Show Details 1 Notices

8. Scroll through the list, and then select the product name.
9. Select a release version.

10. Select the check box next to the required documentation types.
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PRODUCTS

Virtual Services Platform 7000

My Notifications

VIRTUAL SERVICES PLATFORM 7000

Select a Release Version

Virtualization Provisioning Sarvice All and Future o

Visual Messanger™ for OCTEL® 250/350

Visual Vactors

Administration and System Programming

Application Daveloper Information

Visualization Parformance and Fault Manager Application Notaes

Voice Portal

Veoice over IP Monitering
W310 Wireless LAN Gatewa
WLAN 2200 Series

WLAN Handset 2200 Series

11. Click Submit.

December 2016

Application and Technical Notes
Declarations of Conformity

¥ Documentation Library
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Appendix A: Recommendations

The following sections describe how to resolve Virtualization problems, as well as the
recommendations for those errors.
Related links
Rediscoveries and device assignments on page 69
Updating the virtual MAC of a physical adaptor on page 70
Internet browser settings on page 71

Rediscoveries and device assignments

When changes in device assignments are not discovered upon Virtualization start up, but the
changes exist in the assignment list, then devices are shown as unmanaged in the Device Manager.

The following figure shows the Device Management view.

Avaya Fabric Orchestrator Network  Configuration  Backup & Restore  Reports  Wizard Administration  Tools 1P Flow UISENECEE

Topology Inventory Event Monitor Network Profiles Rules Reports  Audit Logs Network Validation [EeISVleCRGELETI T4 E + L _?_ .

H ¥ Q View:  All C Filter Used license count: 0 / 220 "

Device IP MName Description Device Type SPBm Enabled Stack Unit State

Figure 12: Device Management view

Network rediscoveries can result in the following scenarios.

» There is a fault in the discovery or configuration, and you must modify the list accordingly to
allow proper device management.

* You can verify if there were changes made to the Virtualization licensing by accessing the
Configuration network discovery.

In case of a rediscovery, you must take the following measures:

* Viewing the Device Management status on page 59.

+ Displaying a summary of Network Discovery status on page 34.

Related links
Recommendations on page 69
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Recommendations

Updating the virtual MAC of a physical adaptor

Before you begin

This procedure is optional.

Ensure you perform an inventory audit before performing this task.
About this task

If the virtual MAC of a vmnic is set to use a prefix other than the standard 10U, then the switch
information may not be populated correctly during link discovery.. Complete the following procedure
to populate the data switch connection information for the physical adaptors. The physical adaptors
include the switch IP address, as well as the slot and port of the switch to which the ESX or ESXi
server physical adaptor is connected. You can use this tool if you want to populate either the virtual
MAC, or the switch information, or both.

Procedure
1. Extract the vmac_populate_tool.tar or vmac_populate_tool.zip to a temporary folder.
A folder vmac_populate_tool is created.

2. In the CSV file VirtualMaclnput.csv from the vmac_populate tool folder, populate the CSV
entries of each of the physical adaptor virtual MAC using the following format:
<EsxServerName>,<physicalMac>,<virtualMac>,<switchlp>,<switchSlot>,<switchPort>.

3. Complete the following steps:

a. With Telnet or SSH, login to each of the ESX Server and Esxi Server managed by
Virtualization.

b. In the su mode, type the following command: esxcfg-info | egrep 'MAC
Address'.

c. From the output, get the virtual MAC address of each physical adaptor of the Esx
Server.

d. For each mapping, update the CSV file with the entry.

© Note:

Remove any sample entries from the file before you add new entries.

4. After changing the directory vmac_populate_tool, and depending on which operating system
you are running, type the following command:

* On Linux, run the following command: . /parseVMac. sh.

If the script does not have executable permission, run the following command: chmod
0554 parseVMac. sh.

* On Windows, run the following command: ParseVMac.bat.

Before you run the script, update the JAVA_HOME path in the script(ParseVMac.bat) to
the path where JRE 6 is installed, for example, C:\Program Files (x86) \Java
\jreé6. This is required for java command to run.
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Related links
Recommendations on page 69

Internet browser settings

Internet browser settings

Some security settings in Internet Explorer do not allow Java script execution. In this case, the login
page does not show the login button. The following settings are recommended for Internet Explorer.

» Set the Internet Explorer security settings to medium high or lower to allow Java script
execution, as shown in the following figure.

Select a zone to view or change securiby settings.

@ €« v O

] L
Inbernet Loca inkranet  Trusted sites Restricted
skes

¥ trust not to damage your comgeter or
wour files,
‘fious hawe websites in this zone.
Security level fior this 2one
Alowed lewals For this zors: A
Medium

- Prompts before downloading patentially unsafe
content
L] - Unsigned Activel controts will not be downloaded

Custom level,.. !

ipiseopsans N
' 4 This zone corkains websites that you ]

[ Besst all zones bo default kevel

21X

General | Security | Prheacy | Content | Connections | Programs | Advanced

[ Ok ][ Cancel ||_ Apply

J

Figure 13: Internet Options dialog box

» There are additional settings for group policies that disable execution of scripts. Avaya
recommends that you set the same functionality in Firefox, in case the problem persists.

Related links
Recommendations on page 69
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